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Preface

This guide describes how to use the Transporter for Cisco Tidal Enterprise Scheduler 6.2.

Audience
This guide is for administrators who configure, monitor, and maintain the Transporter for Cisco Tidal 
Enterprise Scheduler 6.2, and who troubleshoot Transporter issues.

Related Documentation
See the Cisco Tidal Enterprise Scheduler 6.2 Documentation Overview for a list of all TES guides.

Note We sometimes update the documentation after original publication. Therefore, you should also review 
the documentation on Cisco.com for any updates.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see What’s New in Cisco Product Documentation at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html.

Subscribe to What’s New in Cisco Product Documentation, which lists all new and revised Cisco 
technical documentation, as an RSS feed and deliver content directly to your desktop using a reader 
application. The RSS feeds are a free service.
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Introduction

Overview
The Cisco Tidal Transporter application copies scheduling objects from one database (source) to another 
database (destination). The primary strength of Cisco Tidal Transporter is its ability to automate the 
copying of job data, although it can copy other data types as well. The following discussion refers to job 
transports.

Each database is designed with its own unique needs and purposes. While job data in each database may 
be comprised of many of the same objects, each also uses different objects in defining jobs, such as 
calendar, variable, agent, etc. Ideally, the databases would use the same objects to define a job so a 
one-to-one relationship will exist between the job data in the two databases. Unfortunately, this 
one-to-one relationship rarely exists in the real world. For example, a test environment may refer to a 
different set of agents than the production environment. Using mapping rules, the process of promoting 
jobs from development to test or production databases is highly automated.

Transporter compares the various objects of one database against the other database. Differences 
between the databases are noted and a job rule object from the source database can be matched to a 
different object in the destination database. When copying job rules to another database, Cisco Tidal 
Transporter provides a list of possible values in the destination database that can be selected to make a 
match for the source object without a mate. By mapping out which objects from the source database 
should match which objects in the destination database, subsequent job rules using the same objects can 
be copied without manual interaction.

While Cisco Tidal Transporter is primarily designed to promote jobs between databases, it can also be 
used for synchronizing actions, events, variables, calendars, business views, resources, and job classes 
between two databases. An interactive mode and a batch mode are available for job transports.

Cisco Tidal Transporter has menu options and a toolbar to provide a convenient and easy-to-use interface 
to enhance the object copying process between two databases. The multi-step process is simplified by 
the toolbar mirroring the sequence of steps that comprise the object rule copying procedure.

Basic Steps of the Copying Procedure
Copying objects from one source to another requires copying and/or mapping different types of data 
objects referenced by the objects as much as copying the objects themselves. The process of transferring 
object data between designated source and destination consists of the following steps, though not all of 
the steps may be necessary each time:

1. Connect to the selected source and destination – Select a source to copy the object information from 
and a destination to copy the information to and connect to.
1-7
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2. Select the type of data – After connecting to the source and destination, select the type of data 
to work with.

3. Use a filter to eliminate unwanted job data (applies only to job transports) – The list of jobs can 
be very extensive and difficult to work with without filtering the displayed list. While optional, 
it is recommended to use filtering to reduce the amount of job data displayed from the source. 
Jobs may be filtered by various criteria or wildcards via the Filter dialog.

Use Server Filtering large scale databases, to limit the number of records returned to 
Transporter, which will have a direct performance benefit. Select Include Dependencies when 
using Server Filtering, to ensure the set of jobs returned also include its dependent jobs. 

4. Load the selected data objects – Once the desired data type is within view, load their object 
information by clicking the Read Data button or selecting the Read Data option from the File 
main menu.

5. Specify the data objects to copy – Select the source objects to be copied. Search for specific 
source objects via the search text box and the Find and Next buttons.

6. Resolve differences between the data objects – Map the data objects in the source with 
corresponding destination objects so that objects can easily be copied between the source and 
destination. Mapping is accomplished given the Mappings dialog initiated via the Mappings 
button.

7. Start copying the selected objects to the destination – When object differences have been 
resolved between the source and destination, objects can be easily copied. Job Transports have 
an interactive copying mode where existing differences between source and destination jobs can 
be resolved on the fly. Interactive mode does not exist for other object transport types. 
1-8
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Installing Transporter

Minimum System Requirements
Cisco Tidal Transporter can be installed on a machine running Cisco Tidal Enterprise Scheduler (TES), 
but it does not require it. 

For the system and software minimum requirements for running Transporter, see your Cisco Tidal 
Enterprise Scheduler User Guide.

Prerequisites
Before installing and using Cisco Tidal Transporter, the following requirements need to be fulfilled:

• You need to be properly licensed to use Cisco Tidal Transporter. You do not need to license the 
machine that Cisco Tidal Transporter is installed on. Instead, licensing is handled at the Scheduler 
master that manages the sources that are exchanging job data. Cisco Tidal Transporter cannot work 
with a source unless its master is licensed to use Transporter. The License Administrator for 
Scheduler is used to provide the necessary licensing to enable the use TES. Refer to your Cisco Tidal 
Enterprise Scheduler User Guide for more information on the licensing procedure.

• Before transporting ERP jobs (PeopleSoft, SAP, and Oracle Applications) ensure that the 
destination ERP system/agent meets the requirements to run the transferred jobs.

For example, if running Oracle Applications jobs, verify that the same user responsibility used in 
the source ERP system/agent is available in the destination ERP system/agent. Also the same 
concurrent program or result set referenced in the source ERP system/agent must also be available 
in the destination ERP system/agent. In general, it is recommended that the ERP system/agent 
environment in the destination ERP system/agent mirror the environment in source ERP 
system/agent by using the same release version and the same system configuration.

• TES 6.2.

• 64-bit OS.

• (For large scale databases) Dual Core, 12 GB Ram (16 GB recommended).
2-9
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Installing Transporter
The installation process for Transporter is short and simple. If you are installing Transporter on a 
machine that does not already have Scheduler components installed, an extra step is required to specify 
where to install Transporter. If Scheduler components exists on the machine, the installation program 
installs Transporter into the existing Tidal directory by default.

To install Transporter for Windows:

Step 1 Place the Transporter installation DVD in the DVD-ROM drive of the machine where Transporter will 
reside.

Step 2 Locate the Cisco Tidal Enterprise Scheduler Transporter.msi file in the Transporter folder and 
double-click it to start the installation program.

The Welcome panel displays.

Step 3 Click Next. The Destination Folder panel displays.

Step 4 If a Scheduler component does not already reside on the machine, specify a directory location to install 
the application files. 

Step 5 Click Next.

The Ready to Install the Program panel displays.

The InstallShield Wizard Complete panel displays.

Step 6 Click Install.

The Setup Completed panel displays.

Step 7 Click Finish.

Uninstalling Transporter
Uninstalling Transporter is as simple a process as the initial installation.

To uninstall Transporter on Windows:

Step 1 From the Start menu, select Control Panel, then Add or Remove Programs to display the Windows Add 
or Remove Programs dialog.

Step 2 Select Cisco Tidal Transporter for removal.

Step 3 Click Remove.
2-10
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Getting Started

transporter.props Configuration
transporter.props, if specified, is located under the config directory relative to the Transporter install 
location. This file contains transporter configuration options. 

Some configuration options which may be controlled via transporter.props are as follows:

• UseUnixId – Specifies whether to execute Unix id command to gather user info. Default is false. 
Transporter uses context information unique to the login user to encrypt sensitive data so no one else 
can comprise its secrecy. By default, this user info is gathered using 
javax.security.auth.login.LoginContext API. If the runtime platform is a Unix system and, for any 
reason, it does not fully support this API, you can set this property to true and the Transporter will 
gather user info by the id command instead.

To control logging categories and granularity, specify:

Categories of logging:

– TransporterLog – Used to control logging of general categories including non-job transports

– TransporterJobLog – Used to control logging of job transport operations

– TransporterDataLog – Used to control logging of data related operations

– TransporterUILog – Used to control logging of general UI operations

Logging Levels:

Valid options are SEVERE, WARNING, FINE, FINER, FINEST, with a default of SEVERE, if not 
Logging levels mentioned are the same as those used by Scheduler where a level of SEVERE is the 
least granular (only logging the most severe incidents) while FINEST is the most comprehensive.

To control connection timeouts specify:

– CONNECT_TIMEOUT=20000 (Used to specify a connection timeout in milliseconds; in this 
example, a time of 20 sec has been defined.

– READ_TIMEOUT=20000. (Used to specify a connection read timeout in milliseconds).

To control the number of transporter and session log files retained:

• MaxLogFiles=50 (Used to control the number of Transporter log files retained. Defaults to 50 if 
unspecified).

• MaxSessionFiles=50 (Used to control the number of Transporter session files retained. Defaults to 
50 if unspecified).

To configure Transporter for secure HTTP, specify:
3-11
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Truststore=c:\\temp\\mytruststores\\demo-truststore 

This is used to specify the fully-qualified path of the SSL trust store file to be used if you wish to connect 
Transporter to an SSL enabled Client Manager(s). A truststore file is a key database file that contains the 
public keys for target servers.

Note the use of escaped backslashes for windows directories.

If this configuration option is not specified, you will be unable to define a secured connection during the 
process of defining connection files. See “Creating a Connection”.

There are various tools that allow you to generate keys and certificates and among them is the Java 
Keytool program that comes with the Java JRE installation. All keystore entries (key and trusted 
certificate entries) are accessed via unique aliases. An alias is specified when you add an entity to the 
keystore using the -genkey command to generate a key pair (public and private key) or the -import 
command to add a certificate or certificate chain to the list of trusted certificates. Subsequent keytool 
commands must use this same alias to refer to the entity. When connecting to multiple Client Manager 
servers configured for SSL, your trust store must contain entries for each Client Manager server you 
intent to connect to via HTTPS. You can use the alias to refer to each of these servers. See your Java 
Keytool documentation for specific details.

The following configurations are available in order to provide improved performance for unfiltered job 
reads. Multiple options have been provided for flexibility and the option to be configured may require 
some tuning based on specific user environments. For tuning purpose, it is best to run Transporter in 
debug mode with an open console so that you can view how the reads are performing. To run Transporter 
in debug mode, include XPORTER_DEBUG=YES in Transporter.props and run transporter given 
transporter.cmd script located in bin.

• READJOBS_PAGINATED – configures CM to return job data in pages of READ_BATCHES 
batches. 

For example, READ_BATCHES=1000 and READJOBS_PAGINATED=true
tells CM to return job data in batches of 1000. This approach reduces the overhead on CM as data 
is sent in smaller batches, as opposed to the entire job data in one request. Increasing the 
READ_BATCHES will reduce the number of requests sent to CM, since the jobs are returned in 
larger batches. 

Note Note: This approach may have less benefit given many jobs (i.e. 50K or more). The batching is 
done at the CM level.

• READJOBS_BATCHES – Reads jobs given a range of job id’s, where the range is specified via 
READ_BATCHES.

For example, if you have 50K job records with job IDs starting at 1 and ending at 50,000, and you 
have set READ_BATCHES=1000 and READJOBS_BATCHES=true, requests will be sent to CM to query 
job records, in ranges as follows, until no more records are returned.
1. jobid >=1 and jobid <=1001

2. jobid >=1002 and jobid <= 2002

3. jobid >=2003 and jobid <= 3003

4. …

Note This approach appears to be more beneficial when there are many job records, for example, 
50,000 or more).
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• READJOBS_ALL – This reads all jobs given the first and last job id. The result is that all jobs will 
be read in a single request. This approach is different from the job.getList call in that while both 
return all jobs, this request adds a query condition to the request, which seems to produce better 
performance. However, because all records are returned in a single request, CM will need to process 
all the records for return to Transporter. If there are many job records, the overhead on CM may be 
to high.

Note Only one parameter, READJOBS_PAGINATED, READJOBS_ALL, or 
READJOBS_BATCHES should be set to “true” at a time. Parameter: READ_BATCHES 
applies to READJOBS_PAGINATED or READJOBS_BATCHES.
If none of these parameters is set, the default configuration for read defaults to 
(READ_BATCHES=500, READJOBS_BATCHES=true)

Understanding the Transporter Interface
Start Transporter by clicking Start and selecting Programs>TIDAL 
Software>Transporter>Transporter to display the Transporter interface. 

The Transporter main selection screen is divided into two sections with a Source and Destination side. 
Once connected to their respective source and destination, each side displays data objects that can be 
matched to its corresponding mate in the opposite window. A tabbed view of Transport data types is 
available for selection. Source and Destination object lists are merged into a single table view where 
matching Source and Destination objects are lined up in the same row for easy viewing. As a 
consequence, if the Source and Destination data is very different, there may be gaps in the display. For 
added control over the display, two Preference options are available to control destination display. Refer 
to “Preferences”. 

Note You can adjust the size of these windows by moving the center bar left or right.

Transporter uses a combination of menu options and a toolbar to access and manage the copying of data 
objects between source and destination. 

Main Menus
Transporter contains the following main menus:

• File

• Preferences

• Search

• Transport

• Actions

• Reports

• Help
3-13
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File

The File menu manages the access and loading of file information and Transporter operation. This menu 
contains the following options:

• Connections – Displays the Connections dialog. This dialog is used to create and modify existing 
connections to a source and destination using connection files. Connections files are created in the 
user's transporter home directory. 

For example:

– C:\Documents and Settings\<user>\.transporter

Note The user information is encrypted in the file, using Triple DES Encryption.

Clicking  on the toolbar is the same as selecting the Connections option.

• Connect – Establishes connections to the source and destination. Once connections are established, 
the Connect option is unavailable; only the Disconnect option is available. 

Clicking  on the toolbar is the same as selecting the Connect option.

• Disconnect – Ends the current session as well as the connection to the source and destination sides. 
Once the connection ends, the Disconnect option is unavailable; only the Connect option is 
available.

Clicking  on the toolbar is the same as selecting the Disconnect option.

• Configure – Displays the Configuration Options dialog to customize Transporter for working 
preference. 

Clicking  on the toolbar is the same as selecting the Configure option.

• Read Data – Reads data from both the source and destination for the currently selected object type.

Clicking  on the toolbar is the same as selecting the Read Data option.

• Refresh All – Disconnects and then reconnects to the selected sources.

• Save Map – Displays the Save Tidal Scheduler Map File dialog to save the object mappings that 
have been selected during the current session. The file name you provide is assigned a .map 
extension. You can avoid repeating the manual mapping process for jobs if jobs with the same data 
objects need to be copied again by saving the object map.

• Save Selections (Applies to jobs only) – Displays the Save Selection to File dialog to save the job 
objects selected in the main text field of the source tree. The file name you provide is assigned a .xpr 
extension. Save job selections if you do not want to repeat the same selection process in a future 
session or you want to schedule Transporter in batch mode. Refer to “Running Transporter in Batch 
Mode”.

• Load Selections – Displays the Open Selection File dialog to select and load a selection file that 
was saved from a previous Transporter session.

• Exit – Ends the Transporter session and closes the Transporter application.

Preferences

The Preferences menu allows you to manipulate how data is viewed in the Destination window. This 
menu contains the following options:
3-14
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• Show Unmatched Destination Items – Displays destination objects that have no matching source 
only. The default is False.

• Show Duplicate Destination Objects – Displays destination objects that have a matching source. 
The default is True.

Note If both options are set to OFF, no text displays in the Destination window.

• Expand Groups on Read – Expands all job groups in the current view upon read.

• Collapse Groups on Read – Collapses all job groups in the current view upon read.

Search

The Search menu helps you sort through a potentially large number of data objects that may be displayed 
in the source list. This menu contains the following options:

• First – Finds the first match for the criteria entered in the Search Text field. 

Clicking  on the toolbar is the same as selecting the First option.

• Next – Finds the next match for the criteria entered in the Search Text field. 
Clicking  on the toolbar is the same as selecting the Next option.

• Filter – Displays the Job Filter dialog that provides various text fields to filter the available 
jobs/groups that are displayed in the source. 

Clicking  on the toolbar is the same as selecting the Filter option.

Note To search on data against the destination list, right-click on the Destination pane and select Find First 
or Find Next from the following menu options: 
Find First – Finds the first destination match for the criteria specified in the Search text field. 
Find Next – Finds the next destination match for the criteria specified in the Search text field. 

Transport

The Transport menu organizes the tasks directly concerning the copying of object data. This menu 
contains the following options:

• Mappings – Displays the Scheduler Object Mapping dialog to map the various data objects 
between the source and destination.

• Synchronize – Copies all objects listed in the source listing to the destination. Normally a user 
would not want all of their jobs to be copied at once. The user would select which objects should be 
copied to the destination.

Depending upon the number of objects in the source, using the synchronize option may require a 
lengthy amount of time to complete.

• Start Transfer – Begins the copying process of the selected objects between the source and 
destination. 

Clicking  on the toolbar is the same as selecting the Start Transfer option. 
3-15
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Actions

The Actions menu groups together options affecting the operation of the TES Master and its job 
schedule. This menu contains the following options:

• Pause Scheduler – Pauses the destination TES Master.

• Create Schedule – Recompiles the destination production schedule for the current or future day.

Reports

The Reports menu provides ready access to the main reports and logs provided by Transporter. Reports 
are HTML based and viewed via the system's default browser. This menu contains the following options:

• Mappings Report – Displays the Scheduler Object Mapping Rules report that details the source 
objects that are currently mapped to corresponding destination objects. Recall that the purpose for 
mapping source object to destination objects is to automate the transporting process. 

• Invalid Mappings – Displays a report of mappings that are no longer valid. Mappings may no longer 
be valid if the object was renamed or deleted in the destination. Therefore, no valid mapping 
between a source and destination object can be established.

• Last Activity Log – Displays the Activity Log report for the last transfer operation of the current 
Transporter session.

• Current Session Log – Displays the Activity Log report containing the complete activity log of the 
current Transporter session.

• Past Session Log – Displays the Open Past Activity Log File dialog to select a log file from past 
Transporter sessions. Session logs for Transporter are saved with transporter-timestamp.sess format 
where the timestamp that the session occurred on is affixed as part of the name. Timestamp has the 
format: yyyyMMddHHmmssSSS. 

Help

The Help menu provides information on the version of Transporter and how to use the application. 
Selecting this option launches your default Web browser and allows you to search for a topic. This menu 
contains the following options:

• About – Displays the splash screen for Transporter. The version number of Transporter is displayed 
here.

• Contents – Displays the online help system. You can search for a topic from the Help system’s table 
of contents or use the Search or Index features. 

Toolbar/Buttons 
The toolbar provides one-click access to some of the most frequently used features during a Transporter 
session. The buttons are arranged from left-to-right in approximately the same sequence needed during 
a typical session. The buttons duplicate the same options that are available in the main menu but provide 
more convenient access. The buttons and their purpose are:

•  Source – Launches the Tidal Web Client in your default Web browser for the selected 
source.

•  Destination – Launches the Tidal Web Client in your default Web browser for the 
selected destination.
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•  Connections – Displays the Connections dialog. This dialog is used to create and modify 
existing connections to a source and destination using connection files.

•  Connect – Establishes a connection to the items selected in the Source and 
Destination fields. Once the connection is established, the button changes to Disconnect and when 
clicked ends the connection. Clicking this button is the same as selecting the Connect option in the 
File menu. (A complete refresh of all data objects is accomplished during a session by disconnecting 
and reconnecting.)

•  Disconnect – Ends the connection to the items selected in the Source and Destination 
fields. Once the connection ends, the Disconnect option is unavailable. Only the Connect option is 
available. Clicking the Disconnect button on the toolbar is the same as selecting the Disconnect 
option. (A complete refresh of all data objects is accomplished during a session by disconnecting 
and reconnecting to the source and destination.)

•  Read Data – Reads the object data for the definitions from the selected source and 
destination. Clicking the Read Data button is the same as selecting the Read Data option from the 
File menu.

•  Start Transfer – Begins the data copying process between the selected source and 
destination. (Job transports provide for interactive mapping by transferring individual jobs or job 
groups.) 

Clicking the Start Transfer button is the same as selecting the Start Transfer option in the 
Transport menu. 

Note For Job transports, an individual job or job group can also be transported by dragging and dropping a 
source job or job group to a destination group. Be careful not to drop the job inside the wrong job group 
in the destination inadvertently.)

•  Filter – Displays the Job Filter dialog that provides various filter criteria for filtering of 
jobs/groups that are displayed at the source. 

Clicking the Filter button is the same as selecting the Filter option in the Search menu.

•  Mappings – Displays the Scheduler Object Mapping dialog where the various objects 
from the source can be associated with corresponding destination objects. 

Clicking the Mapping button is the same as selecting the Mapping option in the Transport menu.

•  Configure – Displays the Configure Options dialog to customize Transporter to work 
according to your preference. 

Clicking the Configure button is the same as selecting the Configure option in the File menu.

•  Find – Highlights the first source data object that matches the criteria entered in the search 
text field.

•  Next – Highlights the next source match for the criteria entered in the search text field.

Note To Search on data against the destination list, right-click on the Destination pane and select Find First 
or Find Next from the available menu options available. 
Find First – Finds the first destination match for the criteria specified in the Search text field. 
Find Next – Finds the next destination match for the criteria specified in the Search text field.

• Status Panel – Located at the bottom of the Transporter screen, this panel displays the number of 
objects selected for transport as well as other status messages.
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Tabs
The main Transporter selection screen contains a tabbed view of the following Transport Data types: 

• Jobs/Groups – Displays job and job group definitions that can be copied from the source to the 
destination. 

• Calendars – Displays calendar definitions that can be copied from the source to the destination.

• Business Views – Displays business views that can be copied from the source to the destination.

• Variables – Displays variable definitions that can be copied from the source to the destination.

• Events – Displays the event definitions that can be copied from the source to the destination.

• Resources – Displays resource definitions that can be copied from the source to the destination.

• Actions – Displays action definitions that can be copied from the source to the destination.

• Job Classes – Displays job class definitions that can be copied from the source to the destination.

Securing Transporter
A valid Scheduler user is an LDAP user with a user record in the Tidal Database.

When a user logs in to the Client Manager, it sends the username and password to the LDAP server to 
be authenticated. If the user is disabled in LDAP, that user is not authenticated. Once the user is 
validated, the TESPlugin determines what security policies are in effect for the user. 

Given this, there are two levels of security for a Transporter User. First, the Transporter user must be a 
valid LDAP user in order to access Client Manager for data access via the Transporter application. Once 
the user is authenticated against LDAP, the user's access rights are determined given their Tidal security 
configuration and/or rights to access the data object.

These are the same general requirements required by TES 6.2; refer to TES v. 6.2 documentation for 
further information. Additionally, there are two general security functions specific to Transporter. These 
are Move Jobs to Production and Move Own Jobs to Production. Move Jobs to Production allows a 
Transporter user to transport objects independent of ownership. Move Own Jobs to Production allows a 
Transporter user to transport only owned objects. The Transporter user's ability to access data objects 
for transport is configured given ownership and security policies from the Tidal Web client.

Note A user who has been defined as a Super User has full transport abilities without regard to object 
ownership nor Transporter Security Functions (Move Jobs to Production and Move Own Jobs to 
Production

Note When changing user security policies, Transporter will not automatically update the list of displayed 
data objects, given new policy updates. You should read again via the Read button anytime data is altered 
externally from Transporter. Additionally, for Security policy updates, it will take some time for the 
Client Manager to apply the security updates. If after re-reading data, and the data is still not reflective 
of the user policy updates, Disconnect, Connect and then Read. This will force an immediate update.
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Defining a User in TES
A Transporter user is an interactive user that is either a super user or a non-super user with a specific 
security policy.

To define a user in TES:

Step 1 From the Navigator pane, select Administration>Interactive Users to display the Users pane.

Step 2 Right-click and select Add Interactive User from the context menu, or select and existing user and 
choose Edit Interactive User to display the User Definition dialog.

Step 3 If this is a new user definition, enter the new user name in the User/Group Name field.

Step 4 For documentation, enter the Full Name or description associated with this user.

Step 5 In the Domain field, select a Windows domain associated with the user account required for 
authentication, if necessary.

Step 6 In the Windows/FTP field, enter the password and confirmation password.

Step 7 Click OK to add or save the user record in the Scheduler database.

Authorizing Schedulers to Work With Transporter Data Objects
To define a Security Policy:

Step 1 From the Navigator pane, select Administration>Security Policies to display the Security Policies 
pane, listing all defined security policies.

Step 2 Right-click and select Add Security Policy from the context menu, or select an existing policy and 
choose Edit to display the Security Policy Definition dialog.

Step 3 On the Functions tab, double-click the General category and select the functions to be authorized under 
this policy.

There are two General security functions specific to Transporter, Move Jobs to Production and 
Move Own Jobs to Production. Move Jobs to Production allows a Transporter user to transport 
objects independent of ownership. Move Own Jobs to Production allows a Transporter user to 
transport only owned objects. Super Users have full access to transport objects independent of 
ownership and security policies.

Step 4 Click OK to close the General dialog.

Step 5 Click OK to save the policy.

Note When changing user security policies, Transporter will not automatically update the list of displayed 
data objects, given new policy updates. You should read again via the Read button anytime data is altered 
externally from Transporter. Additionally, for Security policy updates, it will take some time for the 
Client Manager to apply the security updates. If after re-reading data, and the data is still not reflective 
of the user policy updates, Disconnect, Connect and then Read. This will force an immediate update.
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Creating a Connection
Data resources are requested given an HTTP (or HTTPS secured connection), client connection using 
HTTP Basic Authentication. Refer to your TES documentation for more information regarding SSL 
enabled Client Manager configurations.

Connection details are created via the Connections dialog where connection files containing connection 
attributes for establishing connections are created.

To create a connection:

Step 1 In the Connection Name field, enter the name for the connection file.

Step 2 In the Server Name field, enter the name of the Tidal Client Manager machine.

Step 3 In the Master Name field, enter the master instance name.

The master instance name is the TES DSP or Plugin name. This is displayed from the Web UI in the 
Master Status pane.

Step 4 In the Server Port field, enter the listening Web Service port used by the Tidal Web Client. The default 
is 8080 for non-secured connections and 8443 for secured connections.

Step 5 In the User and Password fields, enter a valid TES user name and password. 

Step 6 Select the Secure HTTP option if you want to connect securely through the HTTPS protocol. 

This option is enabled only if Transporter has been configured for secure connections. 

For instructions on configuring Transporter for secure HTTP, see Page 11.

Step 7 Click Save.

The connections file is created in the user's Transporter Home directory. 

For example: 

– C:\Documents and Settings\<user>\.transporter

Note The user information is encrypted in the file, using Triple DES Encryption.

The Connections dialog also contains the following elements not discussed in the procedure above:

• New – Click to create a new connection.

• Rename – Click to rename an existing connection.

• Delete – Click to delete a connection.

• Test – Click to test an existing connection.

• Exit – Click to exit the Connections dialog.

Establishing a Connection
To establish a connection:

Step 1 Select a source from the Source list. 
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Step 2 Select a destination from the Destination list.

Step 3 Once the source and destination are selected, click the Connect button on the toolbar to connect to the 
source and destination.

After the connections are established, click the Read Data button to display a list of data objects based 
on the currently selected data types. This is done automatically if the Read on Connect or New Data 
Type configuration option is selected. After the connections are established, the source and destination 
displays a list of data objects based on the currently selected data types.

Once connected, the Connect option in the File main menu is unavailable and toggles to the Disconnect 
menu option.

If Transporter is currently connected, then the Source and Destination lists are unavailable.

To select other sources, you must first disconnect from the current connection by clicking the Disconnect 
button or selecting the Disconnect option from the File main menu.

Once connected, you can either configure a set of Transporter options or you can Read Data and then 
start selecting the data objects in the source that you want to copy to the destination.
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Configuring Transporter

Overview
Once Transporter is connected to the selected source and destination, you may want to configure the way 
the application works. You can modify how Transporter operates on initial startup and the way it works 
when copying data objects. The configuration options that are selected are saved for future sessions.

Configuring Transporter Options
Clicking Continue on the Transporter toolbar or selecting the Configure option from the File main 
menu displays the Configuration Options dialog.

Use this dialog to configure Transporter to work according to your personal preference.

Some options can be locked down so that no one without Superuser authorization can modify the 
settings. These options have a Restricted check box beside them.

Note Users without Superuser security will not see the Restricted check boxes.

If a configuration option has been restricted, that option is unavailable to other users. These 
configuration restrictions apply only to the selected destination. If another source is selected for the 
destination, then the same restrictions do not apply.

Transporter options are saved in the user's Transporter Home Directory to a file called user.props. For 
example, a file called user.props will be created in the following directory: 

• For Windows: C:\Documents and Settings\<user>\.transporter\config\

Note A user's home directory is different on different platforms. The examples provided are specific to 
internal Windows XP systems and intended for demonstration only. Your configuration will be different.

Following are examples of user home locations by platform:

Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile%
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user>
Microsoft Windows Vista and 7: <root>\Users\<user>
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Configuration Options Dialog
This section describes the options in the Configuration Options dialog.

General Options Section

• Connect on Startup – Connections started to the most recently selected source and destination are 
made whenever Transporter is started.

• Read on Connect/New Data Type – Once a connection is established between the source and 
destination, the data type used in the last Transporter session is read and displayed. If the data type 
is changed during the session, it is also read.

• Include Duplicates (Replace Allowed) – Displays any duplicate data objects on the Source side in 
blue. If this option is not selected, then objects already existing on the Destination side are not 
displayed on the Source side (since there may be no need to copy them again).

Note A job group will be displayed if at least one child job within that job group is not a duplicate even if the 
job group is duplicated.

• Log Directory – Specifies where the session log file(s) are written to. 

By Default, session logs are created with .sess extension and saved to the user's Transporter Home 
directory under a subdirectory called sessions. This default location may be changed given this 
option.

Default location examples:

– For Windows: C:\Documents and 
Settings\<user>\.transporter\session\transporter-20100506025113898.sess

Note A user's home directory is different on different platforms. The examples provided are specific to 
internal Windows XP systems and intended for demonstration only. Your configuration will be different.

Following are examples of user home locations by platform:

Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile%
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user>
Microsoft Windows Vista and 7: <root>\Users\<user>

Transport Options

• Display Warnings – Displays a warning message each time a non-critical issue is encountered as 
data is copied. The operator has to acknowledge each warning message as it is displayed to continue 
the copying operation.

• Annotate – Updates either the Description or Notes (for Jobs) field with the names of the source, the 
user, and the date and time of the transfer of data objects.
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Note If you are copying data objects, Transporter may not be able to annotate these objects. The Description 
text fields of data objects are limited to 4000 characters and there may not be any room available in the 
Description field to add annotations. Deleting text in the object’s Description field will provide room for 
annotations. If Transporter cannot annotate the data objects it is transferring, this is noted in the session 
log. This issue does not apply to jobs that are copied when using the Annotate option.

• Disable Copy – Disables each job, event, or resource as it is copied into the destination. This option 
ensures that the object cannot be used in the schedule until the operator manually enables it. This 
option only applies to jobs, events, and resources; other objects do not have this attribute.

• Job Transport Options Tab

– Auto Select Dependencies – If a job selected for copying has any predecessors, all of its 
predecessors are also automatically selected for copying. This option works in conjunction with 
the Replace Existing Dependencies option.

Note The Auto Select option may affect system performance when used.

– Replace Existing Dependencies – Selects only a dependency if it does not already exist in the 
destination.

– Auto Select Parent Group – If a job selected for copying is a child job, then all of the parent job 
groups it belongs to are also automatically selected for copying.

– Auto Select Children – If a job selected for copying is a parent job, then all of its child jobs are 
also automatically selected for copying.

– Auto Add (no errors, no conflict) – Performs the Job transport operation automatically if no 
conflicts or errors are detected. If a mapping error or conflict occurs, the Job Definition 
Mapping dialog is displayed to resolve the problem interactively.

– Allow Conflicts – Allows a Job transport as long as there are no errors during the copying 
operation, even if mapping conflicts occur. If a conflict between the source and destination is 
not resolved, that job may still run correctly but may be missing dependencies, variables, or 
events, etc.

– Effective Date – Enter a date in the text field or click on the down arrow to display a calendar 
where a date can be selected to indicate the earliest date that the copied job can be compiled 
into the schedule.
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Warning Changing the default Effective Date (current date) from the current date while transferring job groups 
cause severe disruptions in the production schedule. Do not modify the Effective Date option to 
resolve this issue. Instead use one of two methods to transfer a job group with a future effective date. 
Either disable the job group and then transfer it with the default Effective Date (current date) or select 
the Disable Copy and No Compile options in this dialog before transferring job groups. After the job 
group transfer is complete, enable the job group and schedule it as needed.

• Override Options Tab – Sets the default handling of job output. 

Figure 4-1 Configuration Options, Override Options Tab

– Save Output Option – Specifies what will happen to the job's output. If job output is saved, you 
can view it from the Output tab of the Job Detail dialog. You can choose from the following 
options:

• Discard – Does not save the job output. (Default)

• Append – Saves the complete output from each job instance, adding the output to the previous 
job instance’s output.

• Replace – Saves the complete output from each job instance, overwriting the previous job 
instance’s output.

– Summary Only – Selecting this option saves the job output in a summary form. This option is 
useful when jobs have long job output and you do not want the entire output file. Not available 
if the Discard option is selected.

– Allow unscheduled – Enables the job to be inserted into the production schedule on an 
as-needed basis. The default is that unscheduled instances are allowed. If you do not want the 
job to run on an ad hoc basis, you can clear this option to prevent non-scheduled submissions.

– Allow operator rerun – Allows the operator to rerun a job. The default is allow operator reruns 
(options selected).
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– For UNIX, source user’s profile – Allows you to execute Unix user profiles. This option 
provides for the execution of all variables in a Unix user’s profile. Without this option, Unix 
user profile variables that are referenced by scripts are not being executed, causing errors in 
TES.

– Require operator release – Holds the job until an operator releases it. The job will not run until 
it is released. When all the job’s dependencies are met, and it is ready to run, its status is Waiting 
On Operator. The information in the Operator Instructions field (Description tab) can inform 
the operator of any external requirements that need to be met before the job is released.

– Disable carryover – Disables the job carry forward feature that appends the jobs that did not run 
in the current production schedule to the next day's production schedule. Any job from the 
current production schedule that is not in an Active or a Launched status when the next 
production day starts, will not be carried over to the next production day. The default is to enable 
job carry forward (cleared).

• Job Transport Annotation Tab – When an object is transported, a description of the transport 
operation is annotated to the description field of the object, if Annotate is selected. This option 
provides for a customizable annotation message to the job description during transport. Use the 
Configuration Options dialog to supply a global annotation message which will apply to all jobs 
during transport.

To override the global setting during interactive job transport, supply a new value in the Annotation 
tab of the job transport. 

The job is transported with the customized annotation included in the job's notes field. In the 
following example, the annotation has been overwritten by appending with xx at the end. 

Also, a description of the transport operation is annotated at the end of the custom annotation.

Automatic Mapping Option Section

• Dynamically Update Map – Maps the object in the source as soon as a mapping selection is made 
from the destination during job transport.

• Prompt for Map Updates – Each time data objects are selected to resolve conflicts or errors during 
job transport, you are prompted to update the mapping. 

• Do Not Update Map – The paths between objects in the source and destination are manually 
resolved during job transport, but not mapped.

Automatic Compile Option Section

These compiling options are used to control compilation of production schedules at the destination, 
during job transport. When a job is transported, the job update will affect the destination production 
schedule given the options selected.

• No Compile – The changes are not applied until the next time the schedule is compiled. The changes 
do not apply to the schedule currently running (including the future days already compiled).

• Compile-Repeats Start Now – The changes are applied to the schedule currently running. Any 
changes that apply to the repeating jobs within the current day's schedule take effect when the 
schedule is recompiled. This is the same as selecting the Start today's repeating job(s) now option 
that is in the Effective Date dialog displayed in the Tidal Web client whenever adding a repeating 
job with an associated calendar date belonging to the current production schedule.

• Compile-Skip Repeats – The changes are applied to the schedule currently running.

Instances of repeating jobs are skipped if they would have run prior to the current time.
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Loading Data Objects

Overview
Once connections to the selected sources and destination are established, you need to select the type of 
data objects to display and operate on. The Jobs/Job Groups data type is selected by default once a 
connection is established for the first time. The last selected data type is saved once the current session 
is closed and the application terminated. This data type will be selected upon start of the next session. 
To select a different type is a simple matter of selecting the corresponding tab. The type of data object 
that is currently selected is displayed in the title as well as the status panel of the Main Selections dialog.

Selecting the Type of Data Object
The type of data object displayed is managed from the Transport main menu. The type of data object 
displayed is managed given a tabbed, data type view from the Transporter main screen. 

The data type options are:

• Jobs/Job Groups

• Calendars

• Business Views

• Variables

• Events

• Resources

• Actions

• Job Classes

Select a data type for display by selecting the corresponding tab. The list of data objects for each type 
can be very extensive depending upon the sources.

If you are working with job data objects, the number of jobs listed can be very large. With job objects, 
it is recommended that you filter out unwanted jobs before selecting the jobs to copy. The filter criteria 
specified in the current session is saved upon application termination and available for subsequent 
sessions. Only Jobs/Job Groups can be filtered.

From the list of data objects that is displayed, select the objects to copy by clicking in the check box to 
the left of the source object and then initiating the Start Transfer option.
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Selecting the job data type may list an extensive number of jobs, making it difficult to navigate to the 
desired jobs for transport. You should filter which jobs display in the Source field to limit the number of 
jobs that are displayed. Jobs are filtered from the Job Filter dialog.

Job Filter Dialog
The Job Filter dialog is displayed by clicking the Filter button or by selecting the Filter option under the 
Search main menu.

Use this dialog to filter out undesired jobs. The elements included on this dialog are as follows:

• Job – Displays all the job instances that match the specified text string. You can use the wildcard 
characters, * (asterisk) or % (percent sign), in all text fields that use text strings. For example, A* 
will match (display) AB, ABB, and ABBB.

• Group – Filters for all job groups and their child jobs matching the criteria specified in this text 
field. The Show Groups option must be selected before you can use this text field. This text field 
also allows wild card characters.

• Command – Filters for jobs that use a specified command.

• Agent – Filters for all job instances that run jobs on the agent selected from the list. When no agent 
is selected, all agents are assumed. The default is to show all agents.

• Agent List – Filters for all job instances that run jobs for the agent list selected from the agent list.

• Owner – Filters for all job instances that owned by the user or workgroup selected from the list. If 
left blank, jobs belonging to all of the various owners are displayed.

• Calendar – Filters for jobs that use a specific calendars.

• Job Class – Filters for all jobs belonging to the job class selected from the list. If left blank, jobs 
belonging to all job classes are displayed.

• Enabled – Selecting the Yes option filters for all jobs that are enabled. Selecting the No option filters 
for all jobs that are disabled. Leaving this text field blank includes all jobs, whether enabled or not.

• Show Groups – Filters for job groups. Selecting this option ensures that all job groups/jobs are 
displayed according to their parent/child relationships. Leaving this option cleared means that the 
parent/child relationships of job groups are not displayed.

• Defaults – Clicking this button resets the job filter criteria to the default options. This clears all text 
fields of their criteria though the Show Groups option is selected by default.

• Server Filtering – Used to limit the number of records returned to Transporter. A query condition 
that specifies the filter criteria is generated on the database server, and has a direct performance 
benefit, especially for large scale databases. While using server filtering, select the Include 
Dependencies option to ensure the set of jobs returned includes dependent jobs, 

Note The filter is only applied to the Source Database. The destination Database is unfiltered.

After setting the filter criteria for jobs, click the OK button to display only the jobs in the source 
that meet the specified criteria. 

Even after filtering jobs, you may still have more jobs than you want. The specific jobs that will be 
worked with must still be selected.
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Finding a Specific Data Object
If there is an extensive list of data displayed in the source or destination lists, you may have difficulty 
finding a specific data object. Transporter provides a way for you to search for a specific data object 
using a text string.

To find a specific data object at the source:

Step 1 In the Search field next to the Find button, enter a string of text to search for.

Step 2 Click the First button to display the first data object that matches the specified criteria from the source 
list.

Step 3 Click the Next button to go to the next data object that matches the search criteria.

Continue clicking the Next button until you arrive at the desired item.

If no data object matches the search criteria, a “Not found.” message is displayed.

To find a specific data object at the Destination:

Step 1 In the Search field next to the Find button, enter a string of text to search for.

Step 2 Select the Find First menu option from the destination popup menu, to display the first data object that 
matches the specified criteria from the destination list.

Step 3 Select the Find Next menu option from the destination popup menu, to go to the next data object that 
matches the search criteria.

Continue selection of Find Next until you arrive at the desired item.

If no data object matches the search criteria, a “Not found.” message displays.
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Selecting Specific Data Objects
While you may want to copy all of the objects listed in the source, it is more likely that you need to 
selectively designate which objects will be copied.

Figure 5-1 Selecting Data Objects

The following options are available for making your selections:

• For all Data Types, select an individual data object by clicking on the check box to the left of the 
source object to display a check mark.

• For job groups, select a job group by selecting not only the job group but also individually selecting 
its child jobs.

-or-

Right-click on the job group and select the Check Entire Group option from the displayed context 
menu. You can also click on the job group while pressing the SHIFT and CTRL keys to select the entire 
job group simultaneously.

Note Clicking on a job group selects the job group parent and all child jobs within the job group given Job 
Transport Configuration options, Auto Select Parent Group and Auto Select Children.

Context Menu

Note The availability of menu options varies depending on the data type selected.

Right-clicking in the Source or Destination fields displays a context menu of selection and display 
options specific to the data type selected. If a keyboard shortcut is available, it is displayed beside the 
menu option. 

The following options are available in the context menu at the source for the Job type:
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• Check All – Selects all of the listed objects, placing a check mark in each check box.

• Uncheck All – Clears the check box of each selected object.

• Check Entire Group (Applies only to the jobs/groups object type.) – Selects the highlighted job 
group and its child jobs.

• Uncheck Entire Group (Applies only to the jobs/groups object type.) – Clears the check box of the 
selected job group.

• Expand All – Expands all job groups in the source and destination, displaying their child jobs.

• Collapse All – Collapses all job groups in the source and destination, hiding their child jobs from 
view.

• Include Duplicates – Displays all source objects that exist in the destination. A check mark beside 
the menu option means the option is enabled. No check mark beside this menu option means the 
option is disabled. No check mark beside this menu option means that the option is not selected and 
duplicate objects are not displayed.

The following options are available in the context menu at the Destination for the Job type:

• Expand All – Expands all job groups in the source and destination, displaying their child jobs.

• Collapse All – Collapses all job groups in the source and destination, hiding their child jobs from 
view.

• Rename – Allows for the renaming the destination object.

• Enable – Enables a destination object. This option applies to Jobs, Events, and Resources.

• Disable – Disables a destination object. This option applies to Jobs, Events, and Resources.

• Find First – Finds the first destination match for the criteria specified in the search text field.

• Find Next – Finds the next destination match for the criteria specified in the search text field.

Saving the Job/Job Group Object Selections
The process of selecting job objects to copy can be time consuming, depending upon the number of jobs 
you are working with. Creating a selection file will save time and effort when repeating the copying 
process in the future. However, the primary benefit of preserving your selections, is that you can perform 
the copying operation at a later time as a scheduled job in TES.

The selection file saves the names of the source and destination being used, the current configuration 
option settings, and the jobs/job groups that are selected. The information within the selection file can 
be examined by opening the file with a standard text editor program like Notepad. A .xpr extension is 
added when the selection file is saved for easy identification. By specifying the name of the selection 
file as a command line parameter, you can run the job copying process as a batch job in TES. See 
“Running Transporter in Batch Mode”.

To create a selection file:

Step 1 Complete the selection of the job objects between the source and destination.

Step 2 From the File menu, select the Save selections option to display the Save Selections to File dialog.

Step 3 Name and save the file to the desired directory location. Providing a qualified name for the selection file 
will be helpful when searching for the file in the future.
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An Information dialog confirms that the selection file was created successfully.

Loading the Selected Data Objects
If a selections file has been saved, you can load the job/job group data and configuration option settings 
specified in the file by selecting File >Load Selections from the main menu while the job type is in effect. 
The Open Selection File dialog appears. Select the desired file to load the corresponding jobs into 
transporter.
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Mapping Data Objects

Overview
Map data objects in the Source with objects in the Destination so that objects can easily be copied 
between the source and destination. Mapping data is applied to an object's referenced objects and not to 
the actual object itself. Mappings are also used to automate the copying process as discrepancies 
between source and destination object references are automatically mapped given the mapping rules. For 
convenience, mapping rules can be saved in a map file and restored later.

The data objects of the source do not always exist in the destination. These differences can be resolved 
by matching a data object in the source that does not exist in the destination to a different but comparable 
data object in the destination.

The mapping process is done in the Scheduler Object Mapping dialog. In this dialog, a list of the various 
types of data objects is divided into two columns. One column displays the data objects of the source 
and the other column displays the data objects of the destination master. By comparing the source and 
destination side-by-side, you can easily spot any differences that need to be mapped.

The mapping process involves going down the column of source data objects and ensuring that a match 
for the comparable data object that is missing in the destination is mapped. Once the mapping is 
completed, the copying process that transfers the jobs or other data types from one source to another can 
start. Mapping can also be done dynamically for Job transports during the actual copying procedure so 
that a complete map is built over time.

Scheduler Object Mapping Dialog
To display the Scheduler Object Mapping dialog, click the Mappings button on the Transporter toolbar 
or select the Mappings option of the Transport main menu.

The Scheduler Object Mapping dialog displays the following features:

• Object Map Filename – The name of the object map file. By default, the file is given the name of 
the source and given a .map extension.

• Connections – This tab displays a list of defined agent connections that exist in the source and 
provides for a mapping of a corresponding destination agent.

• Agent Lists – This tab displays a list of defined agent lists that exist in the source and provides for 
a mapping of a corresponding destination agent list.

• Calendars – This tab displays a list of defined calendars that exist in the source and provides for a 
mapping of a corresponding destination calendar.
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Note If a selected calendar depends upon a fiscal calendar, the fiscal calendar is also copied with the selected 
calendar.

• Classes – This tab displays a list of defined job classes that exist in the source and provides for a 
mapping of a corresponding destination job class.

• Events – This tab displays a list of defined events that exist in the source and provides for a mapping 
of a corresponding destination event.

• Groups – This tab displays a list of defined job groups that exist in the source and provides for a 
mapping of a corresponding destination group.

• Owners – This tab displays a list of defined users and workgroup owners that exist in the source and 
provides for a mapping of a corresponding destination owner.

• Users – This tab displays a list of defined users that exist in the source and provides for a mapping 
of a corresponding destination user.

• Variables – This tab displays a list of defined variables that exist in the source and provides for a 
mapping of a corresponding destination variable.

• Virtual Resources – This tab displays a list of defined virtual resources that exist in the source and 
provides for a mapping of a corresponding destination virtual resource.

• Custom Resources – This tab displays a list of defined custom resources that exist in the source and 
provides for a mapping of a corresponding destination custom resource.

• Timezones – This tab displays a list of defined timezones that exist in the source and provides for a 
mapping of a corresponding destination timezone.

How To Map Data Objects
Each list that is displayed by clicking one of the buttons listed above is divided into two columns that 
display the selected data object type from the source and destination. If an object type that exists in the 
source also exists in the destination master, it is displayed in the destination column (unless previously 
mapped to a different destination object). If there is no matching object type on the destination side (and 
that object has not been mapped), that space is blank.

On the right side of each Destination text field is a combo box that displays a list of available values. 
Select an object from the list to associate with the source data object. Ideally, you would match up each 
value displayed on the source side with a value on the destination side.

However, the jobs or other data that are being copied may not use all of the values that exist in the source. 
You may wish to map only the data object values that you think are needed and leave the rest unmapped.

Note Mappings apply an object’s referenced objects and not the actual object itself.

The idea behind mapping the data objects is to provide a means to automate copying of data between the 
source and destination. 

With a map file, it is easy to schedule a batch job in TES to copy a job or job group between the source 
and destination. Refer to “Running Transporter in Batch Mode” for information on using Transporter in 
batch mode.
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Default Mapping Option
You can configure a default mapping value for each type of data object. Each list of potential values for 
a data object type in the source starts with a default. This default has no value until it is assigned a 
destination value.

Specify a value for default by selecting a value from the list on the Destination side. This default value 
will be used during object copying whenever a corresponding data object is not mapped in the 
destination.

Not only can using a default value cut down on possible mapping errors, it can also save you considerable 
time. For example, if you are mapping connection objects and a large number of connections exist in the 
Source, but only one connection is used in the Destination, make the one connection the default. This 
avoids having to map each individual object. However, if the default value is incompatible with the type 
of data object being mapped, an error will still result. For example, if a connection object requires a Unix 
value and the default value is a Windows value, an error will result. In another example, an error would 
also result if a text string variable is required but the default value is a date calculation variable.

Remove Mapping Option
One of the options in the list on the destination side is Remove. If there is no corresponding destination 
data object to match an existing data object in the Source, you can just delete any reference to the data 
object when copying objects between Source and Destination. There is no Remove option on the source 
side. It only exists on the destination side.

The Remove option allows a source object to be copied to the destination. For example, jobs must have 
an owner and an agent so you cannot remove the owner or agent data objects.

Note With the Remove option, data is transported to the destination, while “removing” object references that 
had been mapped to Remove. Note that an object's required references cannot be removed; mapping an 
object's required reference to Remove results in an error when trying to transport the object. For 
example, a job is required to have an agent, so if the job's agent is mapped to Remove you cannot 
transport the job.

Saving the Mapping of Data Objects
The mapping process can be time consuming depending upon the number of data objects you are 
working with. If you think you might copy the same data types between the same source and destination, 
you should preserve the mapping you have completed for the selected data objects. Creating a mapping 
file will save time and effort when repeating the copying process in the future. A .map extension is added 
when the mapping file is saved for easy identification.

Creating a Mapping File
To create a mapping file:

Step 1 Complete the mapping of the data objects between the source and destination.

Step 2 From the File menu, select Save Map to display the Save TIDAL Scheduler Map File dialog.
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Step 3 Name and save the file to the desired directory location. Providing a qualified map file name will be 
helpful when searching for the file in the future.

An Information dialog confirms that the map file was created successfully.

The information within the map file can be examined by opening the file with a standard text editor 
program like Notepad.

Mapping Report
Transporter can display reports that list the data objects that were mapped in the current session.

To view a mapping report:

• From the Reports menu, select Mapping Report.

The Scheduler Object Mapping Rules report lists the mapping object type and its corresponding 
mapping rules that are described in a .map file. The report also provides the name of the map file 
and its source and destination. The Mapping Report is displayed in the default browser. See “Sample 
Reports” for an example. Alternatively, you can display the Mapping Report from the Scheduler 
Object Mapping dialog, by clicking the Report button.

Transporter can also list those data objects that it considers have invalid mapping because the data object 
was deleted or renamed in the destination master.

• From the Reports menu, select Invalid Mappings.

The Invalid Mapped Object report lists the mapping object type and its corresponding mapping 
rules that is considered invalid. The report also provides the name of the map file and its source and 
destination master. The Invalid Mapped Object report is displayed in the default browser. See 
“Sample Reports” for an example.

Mapping Timezones
TES can have an associated Timezone. For Transporter, this means that Timezones can be mapped from 
source to destination. 

A Job can reference a Timezone which affects transporting of Jobs. Timezones are referenced via the 
Scheduler Object Mapping dialog.

The following example shows a source Job (with no Parent) with a referenced Timezone. There is a 
matching destination Timezone (AAA TIMEZONE).

The example below shows a Job (with a Parent, \JOB GOUP) with a referenced Timezone that is 
inherited from its Parent Group. There is a matching Timezone in the destination (TIMEZONE 01).

The following example shows a Job (with a Parent, \JOB GOUP) with a referenced Timezone that is 
NOT inherited from its Parent Group. There is a matching Timezone in the destination (TIMEZONE 01). 
Note that Timezone inheritance is independent of other inherited values (unlike Agent inheritance which 
is tied to AgentList and Runtime User inheritance).
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Transporting Data Objects

Overview
When object differences have been resolved using mapping rules, data objects can be easily transported. 
For Jobs, if some differences between the data objects still occur during the transport process, these 
differences can be resolved on-the-fly via the Interactive Job Definition Mapping dialog.

Warning Changing the default Effective Date (current date) from the current date while transferring job groups 
may cause severe disruptions in the production schedule. Do not modify the Effective Date option to 
resolve this issue. Instead, use one of two methods to transfer a job group with a future effective date. 
Either disable the job group and then transfer it with the default Effective Date (current date) or select 
the Disable Copy and No Compile options in the Configuration Options dialog before transferring job 
groups. After the job group transfer is complete, enable the job group and schedule it as needed.

Transport Process
Once an object’s referenced data objects have been optionally mapped between the designated source 
and destination, you can begin the transport process for that object. After selecting the data objects to be 
transported, you can start the transfer between the source and destination in one of four ways:

• Click the Start Transfer button on the toolbar.

• Select the Start Transfer option in the Transport main menu.

• For Jobs, drag and drop a single selected data object (or job group) from the Source side to job group 
on the Destination side.

• Press the F9 key

Note When dragging and dropping job/job groups to the Destination side, be careful that you do place them 
in the intended location. Verify that you are not inadvertently placing the items into the wrong job group.

If there are no problems during the data object transport process, an information dialog displays to notify 
you that the selected number of data objects was successfully transported to the destination.

Note Re-reading object data by clicking the Read Data button on the toolbar or pressing the F5 key updates 
the screen with the current information.
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Visual Cues
Transporter provides visual clues to provide information at-a-glance about the data objects displayed in 
the Source and Destination.

• The data objects in the Source display in blue to indicate that they exist in the destination (unless 
duplicate objects are filtered out). If the object exists in the destination but is disabled at the source, 
its text color will be teal.

• Source objects that do not exist in the destination are displayed in black text unless they are disabled, 
in which case their text is displayed in light gray.

• Newly transported objects in the Destination are displayed in blue text to indicate that they were 
copied during the current session. This is reset when object data is re-read.

Warning If any error messages about connections are displayed while transferring data objects, disconnect 
from the source and destination by clicking the Disconnect button. Resolve the problem and 
reconnect to continue the data transfer.

Data types like calendars, variables, events, resources, actions, and job classes are simple to map since 
they do not have many object references. The owner of these type of data objects is usually is the only 
item that may need to be mapped.

Transporting Job Objects
Jobs are more complicated because of the multiple objects that a job can reference. While there are 
numerous types of data objects referenced in jobs, Transporter is primarily interested in the following 
data objects that are key to jobs in TES:

• Owner – The owner of the job or job group.

• Agent – The agent that will run the job.

• Job Alias – The alias name for the job.

• Parent – The parent of a child job.

• Job Class – The job class, if any, associated with the job or job group.

• Calendar – The calendar, if any, associated with the job or job group.

• Agent List – The agent list, if any, associated with the job or job group.

• Runtime User – The runtime user, if any, associated with the job or job group.

• Variables – The variables associated with a job.

• Job Events – The job events associated with the jobs.

• Job Dependencies – The job dependencies that exist between the jobs.

• Variable Dependencies – The variable dependencies that exist for the jobs.

• File Dependencies – The file dependencies that exist among the jobs.

• Timezone – The timezone defined among the jobs.

• Virtual Resources – The virtual resources defined among the jobs.

• Custom Resources – The custom resources defined among the jobs.
7-40
Cisco Tidal Enterprise Scheduler Installation Guide

OL-32205-01



Chapter 7      Transporting Data Objects
Transport Process
Discrepancies between the values of these data objects in each source and destination should be resolved 
by mapping an equivalent value in the destination to the data object in the source. However, if left 
unmapped, only a subset of these values are considered errors and failure to map these will prevent the 
job transport. Depending on the job type, these required fields are Owner, Agent, Agent List, and 
occasionally Runtime User.

Occasionally, when transporting jobs, a mapping error or conflict may occur. On those occasions, the 
Interactive Job Definition Mapping dialog is displayed to pinpoint and resolve the problem areas.

Interactive Job Definition Mapping Dialog
The Interactive Job Definition Mapping dialog displays during job transport operations unless the Auto 
Add configuration option was selected. If the Auto Add option is in affect, the Interactive Job Definition 
Mapping dialog is only displayed if a mapping error occurs while transporting the job.

Figure 7-1 Interactive Job Definition Mapping Dialog, Key Links Tab

The title bar of the Interactive Job Definition Mapping dialog displays the current point of progress in 
the transport operation (1 of 1). The following text fields are displayed:

• Job Name – The name of the job being transported.

• Type – Indicates the job type (Job, Job Group, FTP job, etc.)

• Errors – Indicates the number of errors that occurred due to failed mappings between source and 
destination objects. Failed mapping for fields such as Owner, Agent or Agent List and sometimes 
Runtime Users (depending on job type) are considered errors. An error prevents a job from being 
transported.

• Conflicts – Indicates the number of conflicts that occurred due to failed mappings between source 
and destination objects. Conflicts indicate a job is missing 
non-critical data such as dependencies or events. While the job may still run with conflicts, the 
missing data may prevent the job from running as expected.
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Note You can use the Delete key to clear out non-required fields and if a field has conflicts, the conflict is also 
cleared.

There are several tabs in the Interactive Job Definition Mapping dialog:

• Key Links – The Key Links tab displays the basic attributes of a job. Three of the fields have 
required mappings, otherwise an error results. These three critical fields are the Owner, Agent, 
Agent List, and Job Alias. 

Note A unique job alias is auto-generated by Transporter and does not usually require user intervention.

Any one of these fields in the To Master Value column that do not map to values displayed in the 
From Master Value column displays a red arrow to highlight a mapping error.

When transporting a job with a parent, the Key Links tab displays an Inherited check box next to 
fields that may be inherited from it’s parent job. The fields are the Agent, Calendar, Timezone, 
Agent List, and Runtime User fields. 

If the source job inherits attributes from its parent, then the check box will be selected next to the 
Inherited check box. If there is an attribute that is currently not inheriting, you can select the 
Inherited check box next to the attribute you want the copied job to inherit. However, if the job 
cannot inherit the attribute due to a failure mapping a corresponding value from the destination, then 
an error results preventing transport of the job. You must resolve this error to continue with the job 
transport.

In Figure 7-1, the source job inherits its Agent, Calendar, and Runtime User from its group 
*AGroup*. A parent mapping conflict occurred because the parent *AGroup* does not exist and is 
not mapped to an alternate group at the destination. However, a parent group is not a required 
attribute of a job, which is why this failed mapping is considered a conflict. Because there is no 
parent selection, the inherited values that cannot be determined are blank in the To Master 
(Destination) side. The non-critical inherited values are displayed as conflicts in blue. The Agent 
field is displayed as an error in red because an agent or agent list is required for jobs. There are 
several options to resolve this error:

– A parent selection can be made as in the following figure. In this case, the selection of group 
Test Group resolved the Agent error because this group has an agent assignment of AGENT 
MSSQL 01 (MSSql). This group also has a calendar and Runtime User.

– A second alternative is to select an agent by clearing the agent Inherited check box. This makes 
the destination Agent list available for selection of an agent value to resolve the agent error. 
Doing so automatically clears the Runtime User check box. You are left with only the Parent 
and Calendar conflicts. You can resolve these conflicts by selecting a parent group and calendar. 
To select a calendar, clear the Calendar inherited check box. This makes the destination 
Calendar list available for selection of a calendar

Note If you have Allow Conflicts configured in the configuration option, you will be permitted to transport 
this job, even with conflicts.

If the job is transported with the Parent and Calendar conflict, the resulting job at the destination 
will not include a Parent nor a Calendar reference.
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A third option is to make an Agent List selection. You can clear the Agent List inherited check 
box which enables the Agent List combo box selection, and then make a selection. This clears 
the agent error and allows transport of the job depending on resolution of any remaining 
conflicts.

Setting Inheritance

The following example includes a job that does not inherit from its parent.

When this job is transported, an error in the Agent field occurs because the source Agent 
AGENT MSSQL 01 is non-existent and is not mapped to an alternate destination value. Because 
an agent or agent list is required for jobs, this is presented as an error. This error can be resolved 
by making an agent or agent list selection.

Since the job includes a parent group, if the parent group has an Agent or Agent List assignment, 
the error can also be resolved by selecting the Agent or Agent List Inherited check box. 

After selecting the Agent Inherited check box, the error is resolved. The corresponding 
destination group has an Agent List assignment rather than an Agent assignment, as does its 
corresponding source group. In this case, selecting the Agent Inherited check box selects the 
Agent List value that is associated with the destination parent group. Note that the Runtime 
User field is automatically set to inherit and its value selected to match the destination parent's 
assigned Runtime User. This is because Agent/Agent List inheritance also assumes Runtime 
User inheritance. 

Selecting the Agent List Inherited check box has the same result. When this job is transported, 
it is created under the group indicated and its Agent/Agent List value and Runtime User values 
inherit from this group.

Note If the destination parent group had no Agent or Agent List assignment, checking the Agent or Agent 
List Inherited check boxes would not resolve the error.

• Variables – The Variables tab displays the variables associated with the job named in the Job Name 
field. These variables are arranged in two columns, From Master Variable and To Master 
Variable. At the bottom of the Variables tab is a Show Usage button that displays how the variables 
are used in the job. Unmapped variables are displayed as conflicts since jobs do not usually require 
variables.

Note You can use the Delete key to clear out non-required fields. This is the same as selecting <<Remove>> 
from the destination list

• Dependencies – The Dependencies tab displays the dependencies associated with the job named in 
the Job Name field. These dependencies are divided into three types of dependencies: job 
dependencies, variable dependencies and file/JES dependencies. Each type of dependency is 
arranged in two columns, From Master Dependency and To Master Variable. Unmapped 
dependencies are displayed as conflicts since jobs do not usually require dependencies.

Note You can use the Delete key to clear out non required fields. This is the same as selecting <<Remove>> 
from the destination list
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Note In the To Master Agent list, use the <<Remove>> option to remove the corresponding File or JES 
dependency. This option is not used to remove an Agent.

• Job Events – This tab displays the job events associated with the job named in the Job Name field. 
These job events are arranged in two columns, From Master Event and To Master Event.

• Resources – This tab displays the job resources associated with the job named in the Job Name 
field. These resources are arranged in two columns, From Master Resource and To Master 
Resource.

Note You can use the Delete key to clear out non-required fields. This is the same as selecting <<Remove>> 
from the destination list.

• Options – This tab allows you to set the default handling of job output.

• Annotation – When an object is transported, a description of the transport operation is annotated to 
the Description field of the object, if Annotate is in effect. This option provides for a customizable 
annotation message to the job description during transport. 

The Interactive Job Definition Mapping dialog displays the following buttons:

• Accept – Accepts the changes you have made, saves the job, and displays the next job to be mapped, 
if any. When there are no more jobs to process, the dialog is closed. If a mapping error is not 
resolved, the Accept button is unavailable and you can only cancel the job and go to the next job for 
processing. The dialog updates with data for each job in process.

• Accept All – Accepts all selected jobs for transport without displaying the mapping dialog for the 
job. Jobs with errors will be skipped. Jobs with only conflicts will be accepted only if Allow 
Conflicts is enabled. Use this option only if you are confident that all items were properly mapped 
earlier. Selecting the Accept All button displays the message”Only jobs without conflicts or errors 
will be accepted automatically. Proceed?”

• Cancel – Closes the displayed job’s mapping dialog without saving any changes to that job and 
moves on to the next job, if any.

• Cancel All – Closes the Job Mapping dialog and cancels processing for jobs that have not yet been 
processed during the current transport operation. Jobs that were accepted earlier during the session 
will still be transported. 

Resolving Mapping Errors and Conflicts For Jobs
The Interactive Job Definition Mapping dialog provides a means to resolve any differences between the 
source and destination on-the-fly. 

Some data object differences are more critical than others. Mapping differences are divided into two 
types called Errors and Conflicts. Transporter provides visual clues to help the user quickly pinpoint any 
mapping problems between source and destination. Colored text in the Interactive Job Definition 
Mapping dialog highlights the tab and field where mapping differences exist.
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Errors
Errors denote more crucial differences between data object. An error occurs when a vital component of 
a job in the source does not exist or is not mapped to an equivalent object in the destination. Errors result 
from missing values in the corresponding data fields that are key to a job. These data fields are the 
Owner, Agent, Agent List, and Job Alias. You can locate the field with the error by looking for the tab 
with red text. On that tab, a red arrow will point to each field containing an error. A job with a mapping 
error cannot be transported until the error is resolved.

From the destination list for the Error field, select a value in the destination that should be mapped to 
the source value. The number in the Errors field will decrease each time an error is resolved. The job 
cannot be successfully transported to the destination until all errors are resolved. 

Conflicts
Conflicts are the less critical difference between data objects. A conflict occurs when a job object 
referenced by the source does not have a corresponding match in the destination. Unlike errors, these 
attributes are not critical. You can locate the field with the conflict by looking for the tab with the blue 
text. On that tab, one or more blue arrows will point to the field(s) causing the conflict. Conflicts do not 
prevent the job from being copied, but the conflicts result in a loss of data if not resolved (e.g., it may 
be missing dependencies or associated events, etc.)

From the destination list corresponding to the Conflict field, select a value in the destination that should 
be mapped to the source value. The number in the Conflicts field will decrease each time a conflict is 
resolved.

Transporting Within the Same Database
When dealing with the same database, the source and destination job cannot be the same. It must be 
mapped to a new parent if there is an existing parent or to a new parent if none exists.

Note Transporting within the same database only applies to Jobs, all other tabs will be disabled.

The transported job is then created under the parent group specified, with the original job undisturbed. 
For example, suppose you have a job group called Sales, which includes jobs relating to sales that were 
originally created under a group called Dev while the jobs are under development. Now, suppose you 
wish to migrate this job to production. You can transport the Sales group, but it must first be mapped to 
a new group. 

Sample Transport Within the Same Database
In the example described above, the following job structure exists where job B depends on job A and

job C depends on job B:

\DEV\SALES\job A, \DEV\SALES\job B, \DEV\SALES\job C

To transport group \DEV\SALES and its child jobs job A through job C:

Step 1 Create a mapping rule for Group DEV. In this example, DEV is mapped to PROD.
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Note In the drop-down menu for group \DEV, you will not be provided an option to map \DEV to itself.

Step 2 Transport SALES and its child jobs. Notice that it's Parent Job is mapped to PROD as per the mapping 
rule above. SALES will be created under parent PROD once transported.

Job A is transported under group \PROD\SALES.

Job B is transported under group \PROD\SALES.

Job B is transported with its job dependency on job \PROD\SALES\Job A.

Job C is transported under group \PROD\SALES and similarly along with its job dependency on 
job \PROD\SALES\Job b.

Because this is the first time that the DEV\SALES group was transported, Transporter creates a new 
group called SALES under the mapped group PROD.

A default annotation is included in the Notes tab that indicates the job was created.

After the initial transport, subsequent transport of group \DEV\SALES results in an update to 
existing \PROD\SALES.

A default annotation is included in the Job notes that indicates the job was updated.

If \PROD\SALES is transported, there will be an error because PROD had not been mapped. To 
resolve this, you can either create a new mapping rule for group PROD via the Interactive Job 
Definition Mapping dialog or you can interactively select a new group from the drop list. \PROD 
will not be available for selection.
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Running Transporter in Batch Mode

Overview
Transporter can run from the command line or as a batch job in TES. Transporter in command line mode 
only applies to jobs. You can either run using an existing selection file or you can specify parameters so 
that Transporter can transfer a job or job group between source and destination as a batch job in TES.

Using Transporter Command Parameters
The following command parameters are required to use Transporter to batch a selection file, job, or job 
group in TES. Also, quotes are required for parameters which include white space.

• -i – The name of the selection file that was created by selecting jobs/job groups at an earlier time. If 
you are using a selection file, you do not need the other parameters as these parameters are specified 
in the selection file (unless you wish to override the parameter values).

• -a – If you are copying a single job, specify its job alias. You must also use the -s, -d, and -m 
parameters with the -a parameter. If a job already exists in the destination, it will still be copied 
unless the -X option is used.

-or-

-g – If you are copying a job group specify the full path with the group name in the following format:

\full path\group name

You must also use the -s, -d, and -m parameters with the -a or -g parameter. If a job group already 
exists in the destination, it will still be copied unless the -X option is used.

• -s – The name of the source. (Required if not using a selection file.)

• -d – The name of the destination. (Required if not using a selection file.) 

• -m – The name of the map file. (Required if not using a selection file.)

In addition, there are other options that can be included in the parameters.

• -D – Disables the jobs that are copied to the destination. The jobs will have to be manually enabled 
before they can be run. 

• -S – Automatically copies all predecessors of the selected jobs as well.

• -A – Annotates the Notes tab of a job/job group definition that the object or job/group was copied 
from another source.

• -X – Excludes duplicates. Does not copy a job or job group already present in the destination.
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• -SP – If a job selected for copying is a child job then all of the parent job groups it belongs to are 
also automatically selected for copying.

• -SC – If a job selected for copying is a parent job then all of its child jobs are also automatically 
selected for copying.

• -C – Compiler option, valid values are OFF (No Compile), NOW (Compile - Repeats Start Now) and 
SKIP (Compile - Skip Repeats).

• -E – yyyyMMdd where (yyyyMMdd is the date format of the effective date for the compile).

• -I – Ignore conflicts.

Running Batch Jobs with Transporter
Transporter can be scheduled as a batch job in TES to copy a job/job group or a saved selection of jobs 
between source and destination.

To run batch jobs with Transporter:

Step 1 Create a job definition in TES and complete the header text fields.

Step 2 In the Command field, enter the path to the command mode transporter executable.

Step 3 In the Command Parameters field, enter the parameters to use when copying the jobs. For example, to 
copy a job with alias 7663 from the fulton destination to the drakken destination:

-s fulton -d drakken -a 7663 -D -S -N OFF -m drak.map

To copy jobs from a selection file named Accont.xpr:

-i Accont.xpr

Step 4 Complete the rest of the job definition as with any other job.

From a Command Line

When scheduling Transporter batch mode to run with the Tidal Agent, the agent must logon using a user 
account with access to Transporter. The following is an example of setting up the agent user account for 
Windows.

The following are examples for scheduling batch-mode transports of jobs:

Example 1

The following dialog shows a group called Level 1 Group copied from source database localhost to 
destination database UBIN-RT-01, while ignoring conflicts. Also, since auto selection parameters 
-S(autoselect deps), -SP(autoselect parents), and -SC(autoselect children) have not been specified, 
transporter will apply the user options set for the current transporter user.

When transporting a single job via the -g (fully qualified group name) or -a (job alias) parameter(s), -m 
(map file name), -s (source database) and -d (destination database) are required. The following example 
also includes -I (allow conflicts).

Also note that quotes are required for parameters which include white space.

The following dialog shows a group called Level 1 Group copied from source database ruibe-bt-01 to 
destination database testvm-bt-01, while ignoring conflicts. 
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Figure 8-1 Example 1

This example uses a selections file to transport job(s), which contains all information required for 
transport. When using a selections file, no other parameters are required, but may be specified if you 
would like to override certain values specified in the selections file.

Transporter Job Exit Codes
If a Transporter job does not complete successfully, it will have one of the following exit codes. Find the 
exit code to diagnose why the job was not successful.

1 = Invalid source specified.

2 = Invalid destination specified.

3 = Processing parameters failed.

4 = Processing selection file failed.

5 = Invalid selection file.

6 = Invalid mapping file.

7 = Unable to find and select all items.

8 = Unable to find the job or job group.

9 = Notify master option has an invalid value. Valid values are Y or N.

10 = Compiler option has an invalid value. Valid values are OFF, NOW and SKIP.

11 = Invalid effective date used.

12 = Group or Job not specified.

13 = Insufficient parameters.

14 = Source and destination must be different.

15 = Unable to connect to source and destination.
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16 = Invalid selection type in selection file.

17 = No items in selection file to be copied.

18 = Not all jobs were copied.
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Working With Reports

Overview
Reports are HTML-based and viewed via your system's default browser. 

Sample Reports

Session Reporting

Figure 9-1 Session Report Example
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Figure 9-2 Invalid Mapping Report Example
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Mapping Report

Figure 9-3 Mapping Report Example
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Last Activity Report

Figure 9-4 Last Activity Report Example

Logging

Session Logs
Session logs are created with a .sess extension and saved to your transporter home directory under a 
subdirectory called sessions, by default. 

The session log directory is configured via the Configuration Options dialog under General 
Options>Log Directory.

• Windows example: 

C:\Documents and Settings\<user>\.transporter\session\transporter-20100506025113898.sess
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Note A user's home directory is different on different platforms. The examples provided are specific to 
internal Windows XP systems and intended for demonstration only. Your configuration will be different. 
Following are examples of user home locations by platform:

Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile%
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user>
Microsoft Windows Vista and 7: <root>\Users\<user>

Diagnostic Logs
New diagnostics logs are created with a .log extension and saved to your transporter home directory 
under a subdirectory called logs:

• Windows example: 

C:\Documents and Settings\<user>\.transporter\log\Transporter-20100506093221628.log

Note Diagnostic logging levels may be controlled via transporter.props. There is no corresponding option for 
session logs, which only contains information about data transport for a given session. See 
“transporter.props Configuration” for further information regarding logging options configurable via 
transporter.props.

Note A user's home directory is different on different platforms. The examples provided are specific to 
internal Windows XP systems and intended for demonstration only. Your configuration will be different. 

Following are examples of user home locations by platform:

Microsoft Windows NT: <root>\WINNT\Profiles\<user> %UserProfile%
Microsoft Windows 2000, XP and 2003: <root>\Documents and Settings\<user>
Microsoft Windows Vista and 7: <root>\Users\<user>
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